MDX-20
MDX-15
USER'S MANUAL
This User's Manual is intended for MDX-20 and MDX-15.

Thank you very much for purchasing the MDX-20/15.
•

To ensure correct and safe usage with a full
understanding of this product's performance,
please be sure to read through this manual
completely and store it in a safe location.

•

Unauthorized copying or transferral, in whole or in
part, of this manual is prohibited.

•

The contents of this operation manual and the
specifications of this product are subject to change
without notice.

•

The operation manual and the product have been
prepared and tested as much as possible. If you
find any misprint or error, please inform us.

•

Roland DG Corp. assumes no responsibility for
any direct or indirect loss or damage which may
occur through use of this product, regardless of
any failure to perform on the part of this product.

•

Roland DG Corp. assumes no responsibility for
any direct or indirect loss or damage which may
occur with respect to any article made using this
product.

For the USA
FEDERAL COMMUNICATIONS COMMISSION
RADIO FREQUENCY INTERFERENCE
STATEMENT
This equipment has been tested and found to comply with the
limits for a Class A digital device, pursuant to Part 15 of the
FCC Rules.
These limits are designed to provide reasonable protection
against harmful interference when the equipment is operated
in a commercial environment.
This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance
with the instruction manual, may cause harmful interference
to radio communications.
Operation of this equipment in a residential area is likely to
cause harmful interference in which case the user will be
required to correct the interference at his own expense.

Unauthorized changes or modification to this system can void
the users authority to operate this equipment.

The I/O cables between this equipment and the computing
device must be shielded.

For Canada
CLASS A

NOTICE

This Class A digital apparatus meets all requirements of the
Canadian Interference-Causing Equipment Regulations.

CLASSE A

AVIS

Cet appareil numérique de la classe A respecte toutes les
exigences du Règlement sur le matériel brouilleur du
Canada.

ROLAND DG CORPORATION
1-6-4 Shinmiyakoda, Hamamatsu-shi, Shizuoka-ken, JAPAN 431-2103
MODEL NAME
: See the MODEL given on the rating plate.
RELEVANT DIRECTIVE : EC MACHINERY DIRECTIVE (98/37/EC)
EC LOW VOLTAGE DIRECTIVE (73/23/EEC)
EC ELECTROMAGNETIC COMPATIBILITY DIRECTIVE (89/336/EEC)
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To Ensure Safe Use
About

and

Notices

Used for instructions intended to alert the user to the risk of death or severe
injury should the unit be used improperly.
Used for instructions intended to alert the user to the risk of injury or material
damage should the unit be used improperly.
* Material damage refers to damage or other adverse effects caused with
respect to the home and all its furnishings, as well to domestic animals or
pets.

About the Symbols
The
symbol alerts the user to important instructions or warnings. The specific meaning of
the symbol is determined by the design contained within the triangle. The symbol at left means
"danger of electrocution."
The
symbol alerts the user to items that must never be carried out (are forbidden). The
specific thing that must not be done is indicated by the design contained within the circle. The
symbol at left means the unit must never be disassembled.
The
symbol alerts the user to things that must be carried out. The specific thing that must
be done is indicated by the design contained within the circle. The symbol at left means the
power-cord plug must be unplugged from the outlet.

Do not disassemble, repair, or
modify.
Doing so may lead to fire or abnormal
operation resulting in injury.

Do not use with any power supply
other than the dedicated AC adapter.
Use with any other power supply may lead
to fire or electrocution.

Use only with the power cord
included with this product.
Use with other than the included power cord
may lead to fire or electrocution.

2

Do not use with any electrical power
supply that does not meet the
ratings displayed on the AC adapter.
Use with any other power supply may lead
to fire or electrocution.

Do not use while in an abnormal
state (i.e., emitting smoke, burning
odor, unusual noise, or the like).
Doing so may result in fire or electrical
shock.
Immediately unplug the power-cord plug
from the electrical outlet, and contact your
authorized Roland DG Corp. dealer or
service center.

Do not use with a damaged AC
adapter, power cord, or power-cord
plug or with a loose electrical outlet.
Use with any other
power supply may
lead to fire or
electrocution.

Do not injure or modify the electrical
power cord, nor subject it to
excessive bends, twists, pulls,
binding, or pinching, nor place any
object of weight on it.
Doing so may
damage the
electrical power
cord, leading to
electrocution or
fire.

When not in use for several hours,
unplug the power-cord plug from the
electrical outlet.

When unplugging the electrical
power cord from the power outlet,
grasp the plug, not the cord.

Failure to do so may
result in danger of
shock, electrocution,
or fire due to
deterioration of the
electrical insulation.

Unplugging by
pulling the cord
may damage it,
leading to fire or
electrocution.

Do not attempt to unplug the powercord plug with wet hands.

Do not allow liquids, metal objects
or flammables inside the machine.

Doing so may
result in electrical
shock.

Such materials
can cause fire.

Install on a stable surface.

Do not touch the tip of the blade
with your fingers.

Failure to do so
may result in falling
of the unit, leading
to injury.

Wear dust goggles and mask during
use.
Cutting dust
may scatter,
causing
bodily injury.

Doing so may result in injury.

Do not allow children to operate
without adult supervision or operate
within reach of young children.
Doing so may result in injury.
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During cutting or scanning, do not
place hands near the blade or the
probe.

In case of emergency, immediately
unplug the AC adapter

Doing so may
result in injury.

While the power is on, do not
remove the spindle unit from the
carriage.
Doing so may
result in
injury.

Store clay out of the reach of
children.

Do not operate if a transparent cover
is cracked or broken.
If the transparent
cover at the front
or the side of the
unit is cracked,
contact a service
agent
immediately for
repairs.

Use a commercially available brush
to remove metal cuttings.
Attempting to use
a vacuum cleaner
to take up metal
cuttings may
cause fire in the
vacuum cleaner.
UP

TOOL
DOWN

When you're finished,
wash your hands to
rinse away all
cuttings.
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About the Labels Affixed to the AC Adapter and Unit
These labels are affixed to the body of this product and the AC adapter. The following figure describes the location.

During cutting or
scanning, keep hands
away from the blade
and the probe.

Rating label
Do not use with any
electrical power
supply that does not
meet the ratings
displayed on the AC
adapter.

UP

TOOL
DOWN

Model name

In addition to the

NOTICE

and

symbols, the symbols shown below are also used.

: Indicates information to prevent machine breakdown or malfunction and ensure correct use.
: Indicates a handy tip or advice regarding use.
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1 What You Can Do with MODELA
Cut material to make a shape
MODELA cuts materials for three-dimensional objects made with software.
You can also engrave plates using flat line-drawing data.

Create three-dimensional data from a shape
MODELA can scan the shape of a solid object and create three-dimensional data.
You can use this data to do things like changing the size or make use of a natural shape as part of another design.

Use software to
create a threedimensional object.

Enter the parameters
for cutting the threedimensional object
(cutting parameters).

Perform cutting.

Finished result.

Perform engraving.

Finished result.

Perform scanning.

Finished result.

Cutting a
shape
3D Design etc.

Use software design
a line drawing.

MODELA Player

Enter the parameters
for engraving (engraving parameters).

Engraving

Dr.Engrave etc.

Prepare the threedimensional object.

2.5D Driver

Enter the parameters
for scanning.

Creating
data from
a shape
Dr.PICZA
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Dr.PICZA

2 Check the Included Items
AC adapter: 1

Power cord: 1

Roland software
package: 1

Spindle unit: 1 (*1)

Sensor unit: 1 (*1)

Cap screw M4 x 15: 4
(Two spares)

Tool: 1
(High speed steel)
The shape of the tool may
differ from that below.

Set screw M3 x 3: 2
(One spare)

Front cover: 1

Hexagonal wrench
(size : 3 mm) :1
Hexagonal wrench
(size : 1.5 mm): 1

Positioning pins: 3 (*2)
(diameter 3 mm (0.118 in.),
length 20 mm (0.787 in.))
(One spare)

Double sided tape: 1

The configuration of the
MDX-15 differs, but the
attachment method is the same.

Clay: 1

MDX-20/15 User's Manual: 1

(*1) Do not discard the included-item box containing the spindle unit and sensor unit.
It is needed to hold the unused unit while Modela is in operation.
(*2) The positioning pin is used when performing double-sided cutting with MODELA.
For detailed information about double-sided cutting, see “Cutting Tips” in the included CD-ROM (refer to "8 Overview of
the Usage Guides").
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3 Part Names
NOTICE

Do not touch the wire with the hands.
Except when repacking the unit, do not attempt to move the table or carriage by hand.

In this manual, sections that explain commons points for the MDX-20/15, use only illustrations of the MDX-20. Some details of
the MDX-15 differ from the figure.

Front
Switch Panel
Carriage
Jack

MODELING
MODE LED
SCANNING
MODE LED
STANDBY key

VIEW LED
VIEW key

TOOL-UP key

Work plate
UP

TOOL
DOWN

Table

TOOL-DOWN key

Rear

Wire

AC adapter jack
Serial connector
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4 Setting Up and Connection

Do not use with any power supply
other than the dedicated AC adapter.

Install on a stable surface.
Failure to do so
may result in falling
of the unit, leading
to injury.

Use with any other power supply may lead
to fire or electrocution.

Do not use with any electrical power
supply that does not meet the
ratings displayed on the AC adapter.
Use with any other power supply may lead
to fire or electrocution.

Use only with the power cord
included with this product.
Use with other than the included power cord
may lead to fire or electrocution.

NOTICE

Never install this unit in any of the following situations, as it could result in damage:
Places where the installation surface is unstable or not level.
Places with excessive electrical noise.
Places with excessive humidity or dust.
Places with poor ventilation, because the MODELA generates considerable heat during operation.
Places with excessive vibration.
Use within a temperature range of 5 to 40°C (41 to 104°F) and within a humidity range of 35 to 80%.
Securely connect the power cord, computer I/O cable and so on so that they will not be unplugged and cause
failure during operation. Doing so may lead to faulty operation or breakdown.

Connecting the AC Adapter and Power Cord
Connect in the order of the numbers shown in the figure.

AC adapter jack

1
10 cm (4 in.)
AC adapter

2
30 cm (12 in.)
Power cord
UP

TOOL
DOWN

30 cm (12 in.)
10 cm (4 in.)
* Do not place any object
within the area

3
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For IBM PC or PC compatible

Serial connector

Crossover
serial cable
UP

TOOL
DOW

N

• For the cable, use a separately available crossover serial cable (RS-232C rating). A straight serial cable such as is commonly used to
connect a modem cannot be used.
• Make sure the power to the computer and the MODELA is switched off before attempting to connect the cables.
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5 Installing the Software
Software That Can Be Used with the MODELA
The Roland Software Package CD-ROM contains many different kinds of software.
You can view the software that can be used with MODELA by displaying the setup menu on the CD-ROM and choosing the model of
MODELA.
See below for overviews and brief description of usage for the software displayed on the setup menu.

Software

Overview

Windows driver

This is necessary when sending data to MODELA from a Windows-based program.
If you’re using Windows, be sure to install this driver.

MODELA programs

The Windows versions of MODELA Player, MODELA 3D DESIGN, and MODELA
3D TEXT cannot be set up separately.

MODELA Player

This sets the required parameters for cutting solid objects and sends the cutting data to
MODELA.
This can import not only solid objects created with three-dimensional programs from
Roland DG Corp., but also solid objects created using other commercially available
three-dimensional programs (via DXF or STL).

MODELA 3D DESIGN

This lets you choose a basic shape such as a cylinder or sphere, and modify it to create
a three-dimensional object.
You can intuitively create solid objects with smooth curves.
You can use MODELA to cut solid objects and save data in three-dimensional DXF
files.

MODELA 3D TEXT

This adds thickness to text to create three-dimensional characters.
It’s also possible to edit text to make it bold, italic, or the like. You can put a box around
text with just a single click — a handy feature when making nameplates.
You can use MODELA to cut three-dimensional text and save data in three-dimensional
DXF files.

Virtual MODELA

This simulates tool movement before performing cutting with MODELA.
You can use it to check the finished shape as well as things like whether the cutting
depth is suitable and how much time cutting will take. This can reduce loss for cutting
materials and time.

Continue on the next page
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Software

Overview

Dr.Engrave

This is used to design plates and send the engraving data to MODELA.
You can make large numbers of plates with the same design with high efficiency. You
can use the TrueType fonts registered in Windows as the font style for text. You can
even make stroke fonts from TrueType fonts.
Because you can the outline of an image and convert it to line segments, it’s also
possible to include logos for companies or organizations in the plates you make.

3D Engrave

This adds thickness to a flat (two-dimensional) graphic to create a relief (raised
engraving).
You can also add thickness to images such as illustrations.

Dr.PICZA

This scans the shape of a solid object with MODELA and creates three-dimensional
data.
You can use it to rescan a particular portion, delete unneeded portions, cut a scanned
three-dimensional object with MODELA, or save data in any of four file formats,
including DXF and STL.

Setting Up the Program
System requirements
MODELA Applications

Dr. Engrave

3D Engrave

Virtual MODELA

Dr.PICZA

Computer

Personal computer running Windows 95, Windows 98, Windows Me, Windows NT 4.0, or Windows 2000

CPU

If you're using Windows 95: i486SX or better (Pentium 100 MHz recommended)
If you're using Windows Me: Pentium 150 MHz or better
If you're using Windows NT 4.0 or Windows 98 : i486DX or better (Pentium 100 MHz recommended)
If you're using Windows 2000 : Pentium 133 MHz or better

System Memory

If you're using Windows 95: 8 MB or more (16 MB or more recommended)
If you're using Windows NT 4.0 or Windows 98 : 16 MB or more (32 MB or more recommended)
If you're using Windows 2000, Windows Me: 32 MB or more

Hard Disk

7 MB or more
of free space

10 MB or more
of free space

10 MB or more
of free space

5 MB or more
of free space

3 MB or more
of free space

Setting Up the Program
If you are installing under Windows 2000 or Windows NT 4.0, you need full access permissions for the printer settings.
Log on to Windows as a member of the “Administrators” or “Power Users” group.
For more information about groups, refer to the documentation for Windows.

1
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Switch on the computer and start Windows.

2

Place the CD from the Roland Software Package
in the CD-ROM drive.
The Setup menu appears automatically.

3

Click the drop-down arrow next to [Click here],
choose the model you're using, then click [Install].
If you're using the MDX-20, choose [MDX-20]. If
you're using the MDX-15, choose [MDX-15].
To view the description of a program, click the
button. To view the manual, click the button.
(There are manuals in PDF format for the programs that the button references. Acrobat
Reader is required to view PDF files.)
If there are programs you don't want to install, then
clear their check boxes before you click [Install].

4

The Setup program starts. Follow the messages to
carry out setup and finish setting up the program.

*

5

The driver settings appear. Check the values, click
[Close], and finish installing the driver.

7

After returning to the menu screen for installation,
click

.

6

8

When the setup for one program finishes, the
setup for the next program starts.
In the interval until the next setup starts, a dialog
box showing the progress of processing is
displayed.

When all installation finishes, the screen shown
below appears.
Click [Close].

Remove the CD-ROM from the CD-ROM drive.
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Changing the Port
When the driver is installed, the port for output from the computer is automatically set to [COM1].
If MODELA is connected to a port other than [COM1], follow the steps below to change the port setting.
Before you make the setting, click [Start], then [Settings], then [Printer] to open the [Printers] folder.
* The explanations in this section describe operation of the MDX-20. If you're using the MDX-15, then where "MDX-20" appears in the
text, read "MDX-15" instead.

<Driver for Windows 95/98/Me>

1

Right—click on
the Roland
MODELA MDX20 icon, then click
Properties.
The [Roland
MODELA MDX20 Properties]
dialog box appears.

2

Click the [Details] tab. At [Print to the following
port(s)], choose an unused port other than
[COM1].

3

Set [Send Retry Time] to 3,600 seconds.
Click the [Port Settings] .
The [Port Settings] tab appears.

4

Make the settings for the following communication parameters.
Click [OK].

2

Click the [Ports] tab. For [Port for Printing],
choose an unused port other than [COM1].
Click the [Configuration Port ].
If you're using Windows NT 4.0, then go on to step
3. If you're using Windows 2000, then skip ahead
to step 4.

<Driver for Windows NT 4.0/2000>
When operation is the same for Windows 2000 and Windows NT 4.0,
screens from Windows 2000 are used in the explanations.
The screens for Windows NT 4.0 may be different.
To make the settings for a printer driver, you need full access permissions for printer setup.
Log on to Windows NT as a member of the “Administrators” or “Power
Users” group.
For more information about groups, refer to the documentation for
Windows.

1
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Right—click on the Roland MODELA MDX-20
icon, then click Properties.
The [Roland MODELA MDX-20 Properties]
dialog box appears.

Click the port you chose in step 2, then click
[Settings].

3

Make the settings for the following communication parameters.

4

Application Settings
When you finish installing the applications, continue by making the following settings. Be sure to make the settings before use.
* The explanations in this section describe operation of the MDX-20. If you're using the MDX-15, then where "MDX-20" appears in the
text, read "MDX-15" instead.

MODELA Player

1

Click [Start].
Point to [MODELA App Group] and click
[mdx3p].

2

From the [Options] menu, click [Machines...].
The [Model Selection] dialog box appears.

3

Click [MDX-20], then click [OK].

4

From the [File] menu, click [Print Setup...].
The [Print Setup] dialog box appears.

5

Click the drop-down arrow for the name and click
[Roland MODELA MDX-20].
Then click [OK].
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Dr.PICZA

1

Click [Start].
Point to [Roland Dr.PICZA] and click
[Dr.PICZA].

3

Select the port where the cable is connected, then
click [OK].

2

From the [File] menu, click [Preferences...].
The [Preferences] dialog box appears.

If You’re Using Windows NT 4.0/2000
If the printer port for the Windows driver and the communication port for Dr. PICZA are set to the same port, you cannot
use Dr. PICZA.
To perform scanning, you need to temporarily set the Windows driver printer port to a different port.
After you finish scanning, return the setting for the Windows
driver to its original value.

Dr.Engrave

1
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Click [Start].
Point to [Roland Dr.Engrave] and click
[Dr.Engrave].

2

From the [File] menu, click [Print Setup...].
The [Print Setup] dialog box appears.

3

Click the drop-down arrow for the name and click
[Roland MODELA MDX-20].
Then click [OK].

3D Engrave

1

Click [Start].
Point to [Roland 3D Engrave] and click [3D
Engrave].

2

From the [Cut] menu, click [Machines...].
The [Model Selection] dialog box appears.

3

Click [MDX-20], then click [OK].

4

From the [File] menu, click [Output Device Setup].
The [Print Setup] dialog box appears.

5

Click the drop-down arrow for the name and click
[Roland MODELA MDX-20].
Then click [OK].
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How to Use Help
If you have trouble using the program or driver, see the help screens. Help contains information such as descriptions of software operation, explanations of commands, and tips for using the software more effectively.

1

From the [Help] menu, click [Contents].

3

Clicking on an image area that contains an
explanation displays the explanation.

2

Clicking on text that is green and underlined (by a
solid or dotted line) displays an explanation.

Tip:
- When the pointer moves over green underlined
text, it changes to a pointing hand (
).
- When the pointer moves over a location where an
explanation is included, it changes to a pointing
hand (
).

When there's a [?] button on screen
Clicking [?] in the upper-right corner of the window makes
). You
the mouse pointer change to a question mark (
can then move the pointer over any item you wish to learn
more about, then click on the item to display an explanation of it.
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When there's a [Help] button on
screen
Clicking [Help] lets you view help for the window or
software.

6 Operation Guide [Cutting Section]
This section provides a step-by-step explanation of the basic procedures for cutting a solid objects with MODELA.
In this section, it is assumed that you have already completed making the three-dimensional data for the solid object. It is assumed that
the three-dimensional data you have prepared is three-dimensional data in DXF format.
- Open the three-dimensional data with MODELA Player and set the cutting parameters.
- Install the blade and mount the workpiece on MODELA.
- Set the reference point for cutting.
- Perform surfacing and start cutting.
This explanation takes the sample data for the MODELA programs as an example of a solid object to be cut.

Create the Cutting Data
Prepare the data to be cut with MODELA, and set the cutting parameters with MODELA Player.

Open the File

1

From the [File] menu, click [Open...].
The [Open] dialog box appears.

2

Choose the desired file and click [Open].

Set the Cutting Parameters
The cutting parameters are the parameters for cutting the solid object.
For MODELA Player, make these settings:
Cutting surface
Size
Depth
Workpiece
Cutting process
Tool
*

: The surface of the solid object to be cut
: The size of the finished object
: The depth of cutting
: The composition of the material to be cut
: The stage of cutting
: The diameter of the blade and the shape of the blade’s tip

When you set the parameters, the optimal movement speed, cutting-in amount, and so on when performing cutting under
these conditions are selected.
When you use materials and tools for which choices are already available, then unless an incorrect selection is made, there is
practically no chance of the tool breaking. Choose the loaded material and the installed tool.
When you use materials and tools for which choices are not available, the cutting parameters must be entered with great care.
An incorrect setting may result in overload that makes it possible for correct cutting to continue, and in worst cases may
cause the tool to break.

19

Make the settings for the cutting conditions. Clicking [NEXT] advances the
setting screens in sequence from A to D.
Make the settings in order from A to D.
(Clicking A, B, C, or D in the figure
displays the corresponding setting screen,
this should not be used except when it's
necessary to make settings independently.)

A
B
C
D
This displays the path of
the tool during cutting.

Click here to advance to
the next settings.

A

B

Select the direction
of the object

Set the dimension

Select the direction to be
used for cutting the object.
In the figure at right,
cutting from above is
selected.

Make the setting for
object's size. Drag the spin
dial up or down, or click
on a number and enter a
value from the keyboard.
Clicking [Resize] makes it
possible to specify a ratio
for the dimensions.

C

D

Set the maximum
cutting depth

Tool diameter/
Material/Finish

Make the setting for the
maximum cutting depth.
Drag the spin dial up or
down, or click on a number
and enter a value from the
keyboard.
Clicking [Center] sets the
depth at a location
proportional to the height.

Tool
Set the type and diameter
of the tool that is installed.
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Material
Choose the composition of
the loaded material.
Finish
When cutting a solid object
on a modeling machine, an
attractive finish can be
obtained by first performing rough (draft) cutting,
then performing fine
cutting. Set to [Draft] for
the first pass, and to [Fine]
for the second pass.

Checking the Cutting Results
If Virtual MODELA is installed and set up, then before you perform actual cutting with MODELA
you can check the shape that will be produced after cutting.

1

From the [File] menu, click [Print Preview].
Virtual MODELA starts.

2

The cutting data from MODELA Player is
imported into Virtual MODELA.
An animated display of tool movement appears,
and the shape after cutting is gradually produced.

*

For more information on how to
operate Virtual
MODELA, see the
help for Virtual
MODELA.

Save the file

1

From the [File] menu, click [Save As...].
The [Save As] dialog box appears.

2

Choose where to save the file, type a filename, and
click [Save]. The file extension is “.mdj”.
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Attach the Spindle Unit

During cutting or scanning, keep
hands away from the blade and the
probe.
Doing so may
result in injury.

NOTICE

Attach the spindle unit securely so that it does not come loose during cutting.

Attach the Spindle Unit
Before attaching the spindle unit, make sure the power to the Modela is switched off.

1

Engage the notch on the spindle unit with the area
of the carriage shown in the figure, and press
down gently with your hand.

When mounting at the low
position
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When mounting at the high
position

2

Insert the cap screws at the locations shown in the
figure, and tighten them loosely using the included
hexagonal wrench (size : 3 mm). After attaching
all two screws in this way, tighten them securely.

3

Make sure the tube is at the position shown in the
figure.
Insert the cord for the spindle unit into the jack.

Tube
Make sure it is
at the base of
the cord.

Position the connector so the arrow
points to the back of the unit and
insert.

The Mounting Locations for the Spindle Unit
There are two locations (heights) for attaching the spindle unit.
Choose the correct location according to the blade length of the tool used for cutting and the thickness of the material.

Spindle unit
Spindle unit
Carriage
Carriage

Approximately
80.6 mm (3-3/16 in.)

Spindle operating
range
60.5 mm
(2-3/8 in.)

Spindle operating range
60.5 mm (2-3/8 in.)

Approximately
20 mm (13/16 in.)

Work plate surface

Approximately
56 mm (2-3/16 in.)

Approximately
116.5 mm (4-9/16 in.)

Load the material and install the tool. When using a base to load the material, mount the base as well.
Make the layout the same as for actual cutting.
Move the spindle to its highest point. When viewed from the side, if the tip of the tool is lower than the surface of the material, remount
the spindle unit at the higher location.
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Install the Blade (Tool)

Do not touch the tip of the blade
with your fingers.
Doing so may result in injury.

NOTICE

Attach the tool securely so that it does not come loose during cutting.

To install a tool, remove the spindle. It’s not necessary to remove the whole spindle unit.

1

While supporting the spindle by hand, remove the
screws at the four places in the figure.

2

Pull out the spindle from below to remove it.

Spindle

3

Insert the blade shank into the spindle.
The cutting tool must not be inserted as far as the
blade.

4

Use a hexagonal wrench (size : 1.5 mm) to attach
the included mounting screws to one side only.

Spindle
Set screw
Cutting tool
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5

Fit the spindle into place as shown in the figure.

7

After all four screws are in place, While supporting the spindle by hand, tighten securely.

6

lift up the spindle until it touches, and while
holding the spindle in that position, use the
included hexagonal (size : 3 mm) wrench to
loosely tighten the screws you removed in step 1.

About the Length of Tool Extending Beyond the Spindle Tip
Care is required regarding the length of tool extending beyond the spindle for the following reasons:
If too short, the tool tip will not reach the desired depth.
If too long, the tool may strike the workpiece when the tool is raised.
The restricted tool length varies according to the mounting location (height) of the spindle unit and the thickness of
the workpiece. For more information, go to "Attaching the Spindle Unit" and see the figure for "The Mounting
Locations for the Spindle Unit."
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Load the Material (Work)
Prepare a workpiece of the necessary size and load it on MODELA.
A block having a margin of a few millimeters larger than the minimum required size is optimal. Cutting time is long if too large, and the
solid object cannot be made if too small.

Maximum cutting area of the MODELA
Z-direction

Bottom surface of the carriage
62.4 mm (2-7/16 in.)
Material thicker than this value cannot be
loaded.
In actual use, the thickness of the loadable
workpiece varies according to the length of the
mounted blade and the thickness of the base.

Work plate surface

X- and Y-direction
MDX-20 : 203.2 mm (8 in.)
MDX-15 : 152.4 mm (6 in.)

: Maximum cutting area
The area demarcated by
lines passing through the
centers of the four holes as
shown in the figure is the
suggested maximum cutting
area.

MDX-20 : 152.4 mm (6 in.)
MDX-15 : 101.6 mm (4 in.)

1

Remove the screws shown in the figure and detach
the work plate.

2

Apply double-sided tape to the workpiece.
Make the adhesive surface broad so that the
workpiece does not come loose during cutting.
With a block like that in the figure, for example,
apply the tape so there are no gaps on any side.

Double-sided
tape

Workpiece

26

3

Mount the workpiece with its corner aligned with
the position of the work plate in the figure.

4

Install the work plate.

When performing
cutting, use the
surface with no grid.

The center of the hole at the lower
left of the work plate is the suggested X- and Y-direction machining
reference point for Modela.
Press in all the way, until flush.

Attach the Front Cover
NOTICE

Be sure to attach the front cover. If not installed, cuttings may scatter and enter nearby computers or other
equipment, resulting in breakdown.

Attach the front cover. If the cover is not attached, the VIEW LED lights (every 1 sec.) up and MODELA does not operate.

Fit the cover plate into place from above
so that it goes into the portion shown in
the figure.

27

Powering ON
NOTICE

1

Before switching on the power to the MODELA, turn on the computer.

Press the STANDBY key.
The STANDBY LED lights up.

2

The unit performs initial operation and stops, and
the VIEW LED and MODELING MODE LED
light up.
* During initial operation, a sound may be heard
for some 20 seconds at the time of origin
detection.

Perform Surfacing

Wear dust goggles and mask during
use.
Cutting dust
may scatter,
causing
bodily injury.

During cutting or scanning, do not
place hands near the blade or the
probe.
Doing so may
result in injury.

NOTICE

Do not allow children to operate
without adult supervision or operate
within reach of young children.
Doing so may result in injury.

Do not operate if a transparent cover
is cracked or broken.
If the transparent
cover at the front
or the side of the
unit is cracked,
contact a service
agent
immediately for
repairs.

Do not perform cutting using cutting oil. Doing so may result in breakdown.

Cut the surface of the loaded material to eliminate unevenness and create a level surface.
This is called "surfacing."
Follow the steps below to perform surfacing.
Refer to each item for the details of each step.

1. Set the depth-direction reference point.
Set the depth-direction reference point on the top surface of the material.
MODELA takes the position of the tool just before starting cutting as the depth-direction reference point.
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UP

TOOL
DOWN

2. Verify the cutting position and the height when the tool is lowered.
Use MODELA Player to move the MODELA tool, then verify the following two points.
- Object Cutting Position
Make sure that the cutting position specified with MODELA Player matches the position of the material loaded on the
Modela.
- Height When Tool Is Lowered
Move the tool, and verify the height when the tool is lowered to the depth-direction reference point.
If the height of the workpiece is not uniform, cutting deeper than the surface of the material may be performed when the
tool is
lowered to a position other than the position set for the depth-direction reference point.
If this happens, then set the depth-direction reference point again.

3. Reset the depth-direction reference point again.
In "2 verify the specified cutting position and the heigt when the tool is lowered," if the blade cut the surface of the material, then you
need to redo the setting.
Reset the depth-direction reference point at the highest position on the material.
If surfacing is started without redoing the setting first, then the amount of cutting in the first pass increases, which may place excessive
load on the tool and make it impossible to complete surfacing.

OK

Not OK
Cutting tool

Amount cut in first pass

Material

Depth-direction
reference point
Cutting tool

Amount of
surfacing

Amount cut in first pass

Material

4. Perform surfacing.

1. Set the Depth-direction Reference point
You cannot set this while the VIEW LED is lit or during cutting.

1

While the VIEW LED is lighted, pressing the key
cancels the paused state.
The carriage moves to MODELA's X- and Ydirection machining reference point.

2

Hold down the TOOL-DOWN key to lower the
blade to close to the surface of the workpiece.

The blade rotates
as it descends
Workpiece
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3

When the blade tip comes close to the material
surface, carefully use the key to lower the blade a
little at a time.

4

When the tip touches the material, release the
TOOL-DOWN key.
After setting the reference point, do not press the
TOOL-UP or TOOL-DOWN keys.

Cutting tool

Workpiece

2. Verify the Cutting Position and Height When the Tool Is Lowered

1

From the [Options] menu, click [Layout...].
The [Layout/Surfacing] dialog box appears.

2

The blue rectangle is the range of the object.
When you double-click one of the black circles
displayed at the corners of the object, the tool
descends to the depth-direction reference point at
that location.
Double-click black circles in the sequence shown
by the numbers in the figure and verify the cutting
position.
To move the object's cutting position, drag the blue
rectangle.

2

1
Black circles
Blue rectangle

3

If the material is cut when you lower the tool at
positions 1 through 3 in step 2, then skip ahead to
the next section, "3. Reset the Depth-direction
Reference Point."
If it is not cut, then proceed to step 2 of "4.
Perform Surfacing" and perform surfacing.
To make the setting for the cutting position only
without performing surfacing, then click [OK].
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3

3. Reset the Depth-direction Reference Point

1

Press the TOOL-UP key to move the blade away
from the material.

2

In MODELA Player's [Layout/Surfacing Settings]
dialog box, In the dialog box, drag the white circle
to move it next to the black circle where you
performed cutting in "2. Verify the Cutting
Position and Height When the Tool Is Lowered."
In this example, it's assumed that the black circle
shown in the figure was cut.

Place cut deeper than
the surface

Move the white circle

3

When you click the

button, the tool moves to

the white circle.

4

Press the TOOL-DOWN key.
Release the key when the tip of the blade touches
the surface of the material.
The depth-direction reference point has now been
reset.

Cutting tool

Workpiece

5

Lower the tool at the four remaining corners with
the new reference point, and make sure that the
material is not cut. (See "2. Verify the Cutting
Position and Height When the Tool Is Lowered" in
the previous section.) If the material is cut, then
repeat steps 2 and 3 and set a new reference point.
* When you view the loaded material edge-on
from the side, if there is any location higher than
the four corners, then move the tool to that
location and redo the setting for the depthdirection reference point.
Redo the setting at the high location
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4. Perform Surfacing
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1

From MODELA Player's [Option] menu, click
[Layout]. The [Layout/Surfacing Settings] dialog
box appears.

3

To change the range and location for surfacing,
clear the selection for [Automatic].
To change the range, drag the solid squares
surrounding the shaded area, or type in numerical
values for [Width] and [Length].
To change the location, drag the shaded portion or
type in numerical values for [Lowerleft X],
[Lowerleft Y].

5

When surfacing ends, click [OK].

2

Enter the surfacing depth.
Here you set the cutting depth from the depthdirection reference point.

4

Click [Start] to start surfacing.
When surfacing ends, the depth-direction reference point is set at the surface after surfacing.

Perform Cutting
A three-dimensional object is cut in two stages: draft cutting and finishing.
First pass
Second pass

Draft cutting
Finishing

High-speed cutting that leaves a margin for finishing
High-precision cutting of the margin on the workpiece surface left by draft cutting

When finishing ends, cutting is complete.
Depending on the composition of the workpiece, however, finishing may not actual produce an attractive finish.
In such cases, use a file or the like to work it by hand.

1

Click [START] to start cutting.

Pausing or stopping operation
Press the VIEW key to quit the cutting operation.

To continue with cutting
Press the VIEW key again.

To end cutting
Stop sending data from MODELA Player.

1

Click [Start].
Point to [Settings] and click [Printers].

2

Double-click the printer icon for the machine
you're using. If you're using the MDX-20, doubleclick the [MODELA MDX-20] icon. If you're
using the MDX-15, double-click the [MODELA
MDX-15] icon.

3

At the [Printer] menu, choose [Purge Print Jobs] or
[Cancel] to stop sending data.
If you're using Windows 2000, choose [Cancel All
Documents].

4

To delete cutting data remaining in MODELA,
press the Modela TOOL-UP and TOOL-DOWN
keys at the same time.
The VIEW LED flashes. When the LED stops
flashing, deletion is finished.
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When Cutting is Finished
When not in use for several hours,
unplug the power-cord plug from the
electrical outlet.

When you're finished,
wash your hands to
rinse away all
cuttings.

Failure to do so may
result in danger of
shock, electrocution,
or fire due to
deterioration of the
electrical insulation.

Use a commercially available brush
to remove metal cuttings.
Attempting to use
a vacuum
cleaner to take
up metal cuttings
may cause fire in
the vacuum
cleaner.

UP

TOOL
DOWN

NOTICE

Be sure to also remove any buildup of cuttings under the machine.
Continuing to use the machine without removing cuttings may result in built-up cuttings getting inside the
mechanism, leading to breakdown.
Do not use an air blower to remove cuttings by blowing them away. The cuttings may get inside the mechanism, resulting in breakdown.

* Be sure to remove cuttings only after MODELA has finished cutting.

1

Press the STANDBY key to switch off the power.

3

Remove fallen cuttings from around the workpiece
and the table.
Metal cuttings
Remove using a commercially available brush.
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2

Remove the workpiece you have finished cutting.
If the workpiece does not peel off easily, use
commercially available ethyl alcohol and a
wooden spatula or the like to remove it.

Other cuttings
Remove using a commercially available brush or with a
vacuum cleaner.

4

Remove any buildup of cuttings from under the
table.
Other cuttings
Detach the work plate and use a vacuum cleaner to
take up any cuttings.

Metal cuttings
Detach the work plate.
While holding down the STANDBY key, switch
on the power to MODELA.
Press the VIEW key and move the table. Use a
commercially available brush to remove any metal
cuttings that are exposed.
After removing the cuttings, hold down the
STANDBY key and switch off the power.

5

Lift up MODELA and also remove any cuttings
that may have fallen underneath.

6

Unplug the power-cord plug from the electrical
outlet.
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7 Operation Guide [Scanning Section]
Attach the Sensor Unit
NOTICE

Attach the sensor unit securely so that it does not come loose during cutting.
Perform installation and removal of the sensor unit while the cover is attached.
If the cover is not present, the probe may be damaged if the sensor unit should fall or be dropped.

Before attaching the spindle unit, make sure the power to the Modela is switched off.

1

If the spindle unit is installed on the carriage, then
remove it. Do this by following the steps in
“Attach the Spindle Unit” in reverse order.

2

Engage the notch on the sensor unit with the area
of the carriage shown in the figure, and press
down gently with your hand.

3

Insert the cap screws at the locations shown in the
figure, and tighten them loosely using the included
hexagonal wrench (size : 3 mm). After attaching
all four screws in this way, tighten them securely.

4

While gently pressing down on the cover with one
hand, loosen the screw shown in the figure.

Screw

Cover
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5

Pull the cover back to remove it.

6

Make sure the tube is at the position shown in the
figure.
Insert the plug for the sensor unit into the jack.

Tube
Make sure it
is at the base
of the cord.

Position the connector so the arrow
points to the back of the unit and insert.

Detaching the Sensor Unit

1

Fit the cover onto the sensor unit as shown in the
figure.

2

While gently pressing down on the cover with one
hand, tighten the screw shown in the figure.

Sensor unit
Cover
Screw

Cover

Sensor unit

Cover

Fit the notch in
the cover into
the area shown
by slanted lines.

3

Remove the sensor unit by following steps 2, 3,
and 6 of "Attach the Sensor Unit" in reverse order.
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Load the Object to Be Scanned on the MODELA
The sensors for the MODELA are highly sensitive, and can even scan three-dimensional objects made out of clay.
You can usually perform scanning if the three-dimensional object is of a composition and configuration that can retain its shape.
However, the pressures that the sensors detect are from several grams to several tens of grams, so you cannot scan objects whose shape
changes when touched by the sensors. (Pressure may fluctuate, depending on the composition of the object being scanned.)
For instance, it may not be possible to scan something like a fuzzy stuffed animal or rubber.
Depending on the shape you're scanning, a maximum error equal to the radius of the probe (0.5 mm) may occur.

Maximum scanning area of the
MODELA

Maximum
scanning area

MDX-20 : 203.2 mm (8 in.)
MDX-15 : 152.4 mm (6 in.)

The maximum scanning area is shown in the figure.
MDX-20 : 152.4 mm (6 in.)
MDX-15 : 101.6 mm (4 in.)

60.5 mm (2-3/8 in.)
1 mm (0.0394 in.)

Work plate
* This space cannot be scanned.

1

Remove the screws shown in the figure and detach
the work plate.

2

Orient so the surface with the grid faces up.
Mount the object to be scanned.
Secure the object to be scanned in place on the
work plate for scanning.
Mount the object to scan securely in place so that
it does not move during scanning.
The grid on the table serves as a guide for
mounting the object to scan.
It does not indicate the scanning area for Dr.
PICZA.
The scale is in 10 mm (3/8 in.) units.
When the shape has a flat bottom and is easy
to secure in place
Secure in place with
double-sided tape.

3

Install the work plate on MODELA and tighten the
screws.
When the bottom is uneven and difficult to
secure in place
When scanning as far as the bottom surface
of the object to be scanned
Make a base using clay, and press the
object into the clay base from above to
secure it in place.

Press in all the way, until flush.
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Attach the Front Cover
Attach the front cover.

Fit the cover plate into place from above
so that it goes into the portion shown in
the figure.

Powering ON
NOTICE

1

Before switching on the power to the MODELA, turn on the computer.

Press the STANDBY key.
The STANDBY LED lights up.

2

The unit performs initial operation and stops, and
the SCANNING MODE LED lights up.

Setting Scanning Conditions and Starting Scanning
About scanning conditions and the scanning area
Y SCAN PITCH

Scanning Area

(Spacing of adjacent scan points along the Y axis)

Workpiece plate

Scanning area

X SCAN PITCH
(Spacing of adjacent scan
points along the X axis)

Scan object
: Scan path
(bidirectional scanning)
: Scan points

Clay
Workpiece plate

Z Upper
Limit
Z BOTTOM
(Height of the scanning
area's bottom plane)

* If you have made a clay base, the height of the
clay is taken to be the Z-axis reference surface.
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Setting scanning conditions and starting scanning

During cutting or scanning, keep
hands away from the blade and the
probe.
Doing so may
result in injury.

Start Dr. PICZA and make the settings for scanning resolution, the lower limit for the height of the surface to scan, and the scanning
quality.

1

Click

on the Dr. PICZA.

2

Make the settings for X scan pitch and Y scan
pitch.

The Controller window opens.
When Dr. PICZA is started, the Controller window
is already open.

3

Make the setting for Z bottom.
If you have made a clay base, the height of the
clay is taken to be the Z-axis reference surface.

4

Make the selection for scanning quality.

5

Select [Smart Scan]. When this is selected,
MODELA identifies and limits the scanning area
before performing scanning (X and Y directions
only).
To specify the scanning area manually, deselect
[Smart Scan], then click [Set Scanning Area]. For
more information on how to specify this, see
“Setting the Scanning Area” in the next section.

6

Click [SCAN] .
Scanning starts.
(During scanning, the sensor may emit a transmission sound, but this is normal.)

For detailed description of the available
Controller buttons,
please refer to the help
screens for Dr.
PICZA.
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If You’re Using Windows NT 4.0/2000
If the printer port for the Windows driver and the communication port for Dr. PICZA are set to the same port, you cannot use Dr. PICZA.
To perform scanning, you need to temporarily set the Windows driver printer port to a different port.
After you finish scanning, return the setting for the Windows driver to its original value.
Use the following examples as a guide to determine the amount of computer memory required to perform scanning.
* The figures shown below are the amounts used by Dr. PICZA alone. They do not take into account the amounts used by the operating
system or other programs.
Example: Required memory when scanning a 100 mm x 100 mm (3-15/16 in. x 3-15/16 in.) area
- Scanning at a pitch of 0.05 mm x 0.05 mm (0.002 in. x 0.002 in.) : Approx. 2 GB
- Scanning at a pitch of 0.1 mm x 0.1 mm (0.004 in. x 0.004 in.) :
Approx. 500 MB
- Scanning at a pitch of 0.5 mm x 0.5 mm (0.020 in. x 0.020 in.) :
Approx. 20 MB

Setting the scanning area
If you wish to limit the scanning area, such as in cases where you wish to scan only a portion of an object, make the settings as described
below.

1

Click

3

Click [Begin Area Test].
The sensor moves to a position above an outer
point on the scanning area that has been set.
Make sure the scan object that has been secured in
place lies within the area.

in the Controller

window. The [Scanning Area] dialog box appears.

2

Make the settings for the scanning area.
Make the settings to match the location where the
scan object is secured in place.
Either of the following two methods can be used to
make the settings.
- Use the mouse to move the blue frame on screen.

Blue frame

- Enter the numerical values for the upper-right
and lower-left points.

The size of the on-screen scanning area (shown in
blue) changes to match the values that are entered.
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4

Click [Z Upper Limit].
The cursor
is displayed on the Z upper-limit
setting on screen.
Specify the highest position of the scan object.
Clicking [Apply] or double-clicking on the target
lowers the sensors to the target's center position.
If the target is displaced, redo the settings.
* Set the Z upper limit to the highest
position on the object to be scanned.
During scanning, if the sensor detects a
position higher than the Z upper-limit
setting, the setting is cleared and scanning
continues with the greatest scan height of
Dr. PICZA as the Z upper limit.

5

After determining the scanning area, click [OK].

6

Check the scanning conditions in the Controller
window one more time, then click
.
Scanning starts. (During scanning, the sensor may
emit a transmission sound, but this is normal.)

- For the scanning area and Z upper limit, please refer to "7 Operation Guide [scanning section] About scanning conditions and the
scanning area".
- For detailed description of the available Controller buttons, please refer to the help screens for Dr. PICZA.

Cancels scanning/Pauses scanning

Cancels scanning. Any
data scanned before being
canceled remains in
memory.

42

Scanning pauses and the
table moves toward the
front of the unit.
Click [VIEW] again to
resume scanning.

Saving Scanned Data

1

Click

and choose [Save].

2

The [Save As] dialog box appears.

Choose the desired location for saving the file,
enter a file name, and click [SAVE].
The extension ".pix" is appended to the file name.

If you want to export the data as a file in DXF or VRML format, please refer to the help screens for Dr. PICZA.
The versions of file formats that can be exported are as follows:
• DXF
AutoCAD® Release 12
• VRLM
Ver.1.0
• 3DMF
QuickDraw 3D 1.5
• IGES
Ver.5.2

Edit the Scanned Data
The shape of an object can be edited. It is possible to vary the height, adjust the slant, or perform concave/convex inversion (height
inversion) for a desired surface.
You can use the toolbar button or select [Edit] on the menu bar.
Please refer to the help screens for Dr. PICZA for detailed explanations of the various functions that are available.
Be sure to save the scanned data before starting to edit.
When you're done editing, be sure to save your file.

When Scanning Is Finished

When not in use for several hours,
unplug the power-cord plug from the
electrical outlet.
Failure to do so may
result in danger of
shock, electrocution,
or fire due to
deterioration of the
electrical insulation.

1

Press the STANDBY key to switch off the power.

2

Remove the scan object from the table.

When not in use
- Remove any clay from table, and store the clay so that it will not dry out.
- Unplug the power-cord plug from the electrical outlet.
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8 Overview of the Usage Guides
The included Roland Software Package CD-ROM contains the following PDF files.

- Cutting Tips
This describes tips and tricks for double-sided cutting and methods for securing the workpiece in place.

- Scanning Tips
This describes how to shorten scanning times and perform rescanning.

Location of the Usage Guides
The usage guides are found at the following locations.
View the following files directly from the CD-ROM, or copy the following files to your hard disk and read them from there.

Cutting Tips : [Document] - [Cuttips] - [Cuttip-e.pdf]
Scanning Tips : [Document] - [Scantips] - [Scatip-e.pdf]

Installing the Acrobat Reader
Acrobat Reader is required to view PDF files.
If Acrobat Reader is not set up on your computer, you need to set it up.
The included CD-ROM also contains Acrobat Reader.
[Acrobat] - [English] - [ar405eng.exe]
(This runs under Windows 95, Windows 98, Windows Me, Windows NT 4.0 or Windows 2000.)
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9 Software Guide
This describes the general procedures for software you can use with MODELA.
For detailed descriptions, take a look at the help screens for the respective software.
* The explanations in this section describe operation of the MDX-20. If you're using the MDX-15, then where "MDX-20" appears in the
text, read "MDX-15" instead.

Driver for Windows 95/98/Me
This sends data to MODELA from a Windows-based program.
When sending data from Dr. Engrave or a commercially available drawing program, the driver sets engraving parameters such as the
tool’s operating speed, depth, and pitch.
When sending data from MODELA Player or 3D Engrave to MODELA, the data is sent to the driver’s output port. At this time, all driver
settings other than the port are ignored, and do not affect cutting.
This section explains how to make the settings for the engraving parameters.

Display the Driver Setting Screen
To make the settings for the driver, open Properties. You can use either of the two methods described below to open Properties.

Method 1
When you use this method to make the settings, any changes you make in Properties also affect other Windows-based programs.

1

Click [Start]. Point to [Settings] and click
[Printer].
The [Printers] folder appears.

2

Right-click on the [Roland MODELA MDX-20]
icon, then click [Properties].

2

Set the printer to [Roland MODELA MDX-20],
then click [Properties].

Method 2

1

From the [File] menu, click [Print Setup...].
The [Print Setup] dialog box appears.
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Enter the Cutting Area
Enter the size of the plate installed on MODELA.

1

Click the [Size] tab.

2

Enter values for [Width] and [Length].

Set the Engraving Parameters
Make the settings for the composition of the workpiece to engrave and the engraving depth.
Choosing the composition sets engraving parameters suited to this engraving. However, [Z Down Position] and [Fill Pitch] are determined with no relation to composition, and so they are set separately. For [Z Down Position], enter the engraving depth. For [Fill Pitch],
enter the tool diameter.
The values for settings other than [Z Down Position] and [Fill Pitch] are also suggested guidelines. If the results of actual engraving are
not as expected, modify the values accordingly.
Lines are distinguished by color, and parameters when engraving a line of the corresponding color are set.
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1

Click the [Tool] tab.

2

Click the drop-down arrow for [Material], then
click the composition of the engraving material
(workpiece).

3

Click the tab for the color to set.
The numeral appearing next to the color is the tool
number that is now set.

4

Click the drop-down arrow for [Tool], then click
the tool number.
If you don’t wish to engrave lines of that color,
click [None].

5

For [Z Down Position], enter the cutting-in depth.

6

For [Fill Pitch], enter the diameter of the tool tip.
To achieve an attractive finish, enter a value
narrower than the actual diameter.

For [Fill Pitch] and items other than [Fill Pitch], suitable values are set for engraving the composition you chose in
step 2. However, these values are only suggestions. If the results of actual engraving are not as expected, adjust the
values accordingly.

Driver for Windows NT 4.0/2000
This sends data to MODELA from a Windows-based program.
When sending data from Dr. Engrave or a commercially available drawing program, the driver sets engraving parameters such as the
tool’s operating speed, depth, and pitch.
When sending data from MODELA Player or 3D Engrave to MODELA, the data is sent to the driver’s output port. At this time, all driver
settings other than the port are ignored, and do not affect cutting.
This section explains how to make the settings for the engraving parameters.
To make the settings for a printer driver, you need full access permissions for printer setup.
Log on to Windows as a member of the “Administrators” or “Power Users” group.
For more information about groups, refer to the documentation for Windows.
The descriptions of the following procedures use screen shots from Windows 2000.

Display the Driver Setting Screen
To make the settings for the driver, open Properties. You can use either of the two methods described below to open Properties.

Method 1
When you use this method to make the settings, any changes you make in Properties also affect other Windows-based programs.

1

Click [Start]. Point to [Settings] and click
[Printer].
The [Printers] folder appears.

2

If you're using Windows 2000, right-click the [Roland
MODELA MDX-20] icon, then click [Printing
Preferences].
The [Printing Preferences] dialog box appears. Click
[Advanced].
If you're using Windows NT 4.0, right-click the
[Roland MODELA MDX-20] icon, then click
[Document Defaults].
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Method 2

1

From the [File] menu, click [Print Setup...].
The [Print Setup] dialog box appears.

2

Set the printer to [Roland MODELA MDX-20],
then click [Properties].
If you're using Windows 2000, the [Property]
dialog box displays. Click [Advanced].

2

Click [Add New Work Size], then for [Work Size],
enter values for [Width] and [Length].

Enter the Cutting Area
Enter the size of the plate installed on MODELA.
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1

Click the [Work Size Settings] document option.
For Windows 2000, click [Properties]. For
Windows NT 4.0, click [Work Size Settings].

3

Enter the [Work Size Name], then click [OK].
* For [Work Size Name], use only alphanumeric
characters.

Set the Engraving Parameters
Make the settings for the composition of the workpiece to engrave and the engraving depth.
Choosing the composition sets engraving parameters suited to this engraving. However, [Tool Down Position] and [Fill] - [Tool Width]
are determined with no relation to composition, and so they are set separately. For [Tool Down Position], enter the engraving depth. For
[Fill] - [Tool Width], enter the tool diameter.
The values for settings other than [Tool Down Position] and [Fill] - [Tool Width] are also suggested guidelines. If the results of actual
engraving are not as expected, modify the values accordingly.
Lines are distinguished by color, and parameters when engraving a line of the corresponding color are set.

1

Double-click any tool from 1 to 4 to display the
lower level.
Click [Material], then click the composition of the
engraving material (workpiece).

2

Double-click [Color] to display the lower level.
Click the color to set, then click the tool number.
If you don’t wish to engrave lines of that color,
click [None].

3

Double-click on the tool number to display the
lower level.
Click [Tool Down Position] and enter the cuttingin depth.

4

For [Fill], click [Tool Width], then enter the
diameter of the tool tip.

For items other than [Tool Down Position] and [Fill] - [Tool Width], suitable values are set for engraving the composition you chose in step 1. However, these values are only suggestions. If the results of actual engraving are not as
expected, adjust the values accordingly.
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MODELA 3D DESIGN
This lets you choose a basic shape such as a cylinder or sphere, and modify it to create a three-dimensional object.
You can intuitively create solid objects with smooth curves.

Choose the basic shape

1

Click

2

.

Click the basic shape that is closest to the finished
form. Enter the size, then click [OK].

The [Primitives] dialog box appears.

Decide on the number of reference lines
The reference lines are control rods for arranging the shape of the object.
To determine the number of reference lines, click the controls shown below.

: 4 lines

: 7 lines

: 10 lines

Manipulate Reference Lines to Make a Shape
To change the height of a reference line, position the
pointer over the reference line and drag it up or down.
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To change the size of the outer perimeter for a reference
line, position the pointer over the reference line and drag it
to the left or right.

To change the shape of the outer perimeter, right-click on
a reference line.
The [Select section] dialog box appears.
Make the settings to obtain the desired shape.

To change the centerpoint of the outer perimeter, click
and drag the reference line.

Check the shape

1

Click the

.

The [Rendering] dialog box appears.

2

Drag the scroll box for the X, Y, or Z scroll bar.
The object rotates, letting you view it from various
perspectives. To color the object, click [Start].

Save the data
Click the

.

The [Save As] dialog box appears.
Enter the name of the file and click [Save].
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Description of Controls
This opens new file.

This saves the data as a DXF file.

This opens an existing file.

This starts MODELA Player.

This saves the file, overwriting the previous data.

This undoes the very last operation.

This moves a reference lines up or down.
When
is selected, the location of the
centerpoint moves up or down.
This moves a reference lines right and left.
When
is selected, the location of the

This zooms the screen in or out.

This displays the coordinates of the reference
lines.
This changes the point of view.

centerpoint moves right and left.
When this is selected, dragging a reference line
changes the size of the outer perimeter.
When this is selected, dragging a reference line
moves the centerpoint of the outer perimeter.

This adds color and shadowing to the object's
surfaces.
This determines the number of
reference lines.
This displays help for 3D DESIGN.

MODELA 3D TEXT
This adds thickness to text to create three-dimensional characters.
You can use the TrueType fonts registered in Windows as the font style for text.

Enter the Text
Click the [Edit] text box, then type in the text.
Make sure what you’ve typed in is correct, then click [Go!].
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Determine the Font and Size of the Text

1

Click the [Font] drop-down arrow, then click on a
font name.

2

Click the [Scale] drop-down arrow, then click on a
size.

- You cannot specify a font size that is not listed.
- If you want to know the size of the entire text string that you typed in, click [Show Information].

Save the data
Click the
.
The [Save As] dialog box appears.
Enter the name of the file and click [Save].

Description of Controls
This opens new file.

This lets you choose the color of the object from
among ten available colors.

This opens an existing file.

This assigns the desired color to the object.

This saves the file, overwriting the previous data.

This displays dimensions around the object.

This changes how the object is displayed.

This saves the data as a DXF file.

This starts MODELA Player.

This slants each individual character to the
left or right.

This slants the text in the height direction.

This puts a frame around the text.

This changes the height of the text.

This rotates each individual character 90 degrees
counterclockwise.

This determines the roughness of curved
portions of the text.

This makes the text italic.

This inverts the background color.

This makes the text bold.
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MODELA Player
For information on how to use MODELA Player, see “6 Operation Guide [Cutting Section].”

Virtual MODELA
You can use a tool path created with MODELA Player or 3D Engrave to verify the cutting process and results on-screen before you
perform actual cutting.
You can start this program directly with commands from MODELA Player or 3D Engrave. For more information, see "6 Operation Guide
[Cutting Section] - Sending Cutting Data" or "9 Software Guide - 3D Engrave."
With Virtual MODELA, you can display the cutting process and results in a wide variety of ways.

Animating the Screen During Simulation
Click the

. When this button is off, only the shape after simulation is displayed.

Switching the Screen Between Flat and Three-dimensional Views During Simulation
•

Clicking
switches from a flat view to a three-dimensional view.
When this button is selected, the view is three-dimensional during and after simulation.

•

Clicking
switches from a three-dimensional view to a flat view.
When this button is selected, the display shows a view of the workpiece as seen from above during and after simulation.

Changing the Perspective at the Simulation Screen (Only During 3D
View)
You can use the following buttons only when

has been clicked to display a 3D view.

•

Clicking

rotates the object counter-clockwise around the Z axis, in steps of 90 degrees.

•

Clicking

rotates the object clockwise around the Z axis, in steps of 90 degrees.

Checking the Shape After Simulation
You can use the following buttons only when

has been clicked.

• Rotating
You can use the following buttons only when
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has been clicked.

• Zooming in or out
Click

, then drag on the screen.

Zoom in
Drag toward the top of the screen.
Zoom out
Drag toward the bottom of the screen.

• Moving the Location
Click

, then drag on the screen.

Description of Controls
This creates a new, uncut workpiece.

This opens an existing cutting-configuration file.

This saves the shape of the present workpiece in a
file.
This performs the cutting simulation over again,
using the presently imported tool path. Use this
when you want to check the movement of the tool
again.

This quits the simulation.

This starts cutting.
If cutting was previously interrupted, it resumes
cutting.

This switches between adding and not adding color
to the surface of the workpiece.
To specify a color, click [Options] - [Surface Color].
This restricts the 3D view range.
It also determines the printing area when performing
2D simulation.
Restricting the range makes 3D view faster than
when displaying the entire workpiece.
This pastes and image on the surface of the
workpiece.
By pasting an image of wood or metal, you can
make the workpiece look more realistic.
T o select the image to paste, click [Options] [Texture Setup].
This rotates the object, changing the perspective.
This is available only during 3D view.
This zooms the view of an object in or out.
This is available only during 3D view.

This displays a prediction of how much time cutting
will take. The time is a general estimate.
In addition to the time, you can also verify the tool
movement distance and movement range.

This changes an object's displayed location on the
screen.
This is available only during 3D view.

This displays the simulation screen as a flat (twodimensional) view.

This enlarges or reduces what is displayed to fill the
drawing size.

This displays the simulation screen as a solid (threedimensional) view.
These change the perspective when displaying a simulation three-dimensionally.
This is for checking the shape after cutting simulation.
This displays the movement of the tool with
animation.

This selects how the object is
displayed when on the 3D
screen when not performing any
operation.
This selects the image to paste on the surface of the
workpiece.
This changes the direction and brightness of incident
light, thereby changing the shading.
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Dr.PICZA
For information on how to use Dr. PICZA, see “7 Operation Guide [Scanning Section].”
This section describes the controls for Dr. PICZA.

This unhides and hides the controller window. At
the controller window, you can make the settings
for the various scanning parameters.
These choose how an object moves when
dragged.

These display the coordinates of the point chosen
with the mouse pointer.
Clicking a start point and an end point shows you
the distance between the two points.
This undoes the very last operation.

This displays the top surface of an object.
These color a surface of the object.
These zoom the view of an object in or
out.

These specify the edit area for
three-dimensional data.

This displays the object, filling the view area.
This specifies the range to rescan.
These choose how an object is
drawn.

These edit three-dimensional data.

These adjust the slant of an object.
This deletes data in the selected range.

This saves data in various file formats.

This starts MODELA Player.
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Dr. Engrave
This is used to design plates and send the engraving data to MODELA.
You can make large numbers of plates with the same design (such as nameplates and rating plates) with high efficiency.

Set the Engraving Area
The following explanation is for Windows 95/98/Me. If you're using Windows NT or Windows 2000, then refer to the explanation in "9.
Software Guide Driver for Windows NT 4.0/2000 Enter the Cutting Area."

1

From the [File] menu, click [Print Setup...].
The [Print Setup] dialog box appears.

2

Make sure [Roland MODELA MDX-20] is
specified as the printer, then click [Properties].
The [Roland MODELA MDX-20] dialog box
appears.

3

Enter the size of the plate, then click [OK].
Next, click [OK] to close the [Printer Setup] dialog
box.

4

The white portion of the screen is the engraving
area. Lay out shapes and text inside the area.

Type in the Text
Click

, then click at the location where you want to type in text.

While in this state, type in the text with the keyboard.
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Draw a Shape
Click on the shape-drawing controls to draw the shapes.

Change the Size and Location of a Shape or Text
Click

, then click the shape or text.

Solid square (

) and triangle (

) pointers appear around the shape or text. To change the size, drag the pointers.

<Changing the Size>
Drag to change the vertical size.
You can freely change the size of the
object by dragging. To retain the
object’s vertical/horizontal aspect
when you change its size, hold down
the [Shift] key while dragging.

Drag to change the horizontal size.

<Rotating and Slanting>
Clicking again makes the pointers change to circles (
Drag to rotate the shape.

<Moving the Location>

To change the location, drag between
the pointers.
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) and diamonds (

).
Drag the “

” to slant the shape.

Save the Data
Click the

.

The [Save As] dialog box appears.
Enter the name of the file and click [Save].

Start Engraving
Click the

.

The [Save As] dialog box appears.
To start engraving with MODELA, click [OK].

Description of Controls
This opens new file.

This zooms the screen in or out.

This opens an existing file.

This types in the text

This saves the file, overwriting the previous data.

This draws the shapes

This sends engraving data to MODELA.

This deletes the selected object and copies it to the
clipboard.

This makes an entry frame for text.

This copies the selected object to the clipboard.

This changes the chosen text string to line
characters.

This copies the clipboard data to the screen.

This performs flat-drag machining for the interior
of a shape or text.

This selects a shape or text.

This is used to reposition the vertices of a polygon,
changing its shape.

These change the context of an object.

These set the direction of the text string.
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3D Engrave
This adds thickness to a flat (two-dimensional) graphic to create a relief (raised engraving).
You can also add thickness to images such as illustrations.

3D Engrave is a program for creating reliefs (raised engravings) and engravings on curved surfaces.
This section describes the steps for cutting a relief.
For detailed descriptions of the creation steps and more information about creating data for engraving,

Select the Output Device
See "5 Installing the Software - Program Settings" and choose the model you're using.

Decide on the Size of the Relief
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1

From the [Relief] menu, click [Relief Size].
The [Relief Size] dialog box appears.

3

The screen at right appears. The white area of the
screen is the where you design the relief.
The screen displayed at this time is called the "2D
screen." It's the screen for typing in text and
creating shapes.

2

Enter the size of the relief and the resolution (the
degree of detail of the relief), then click [OK].

Creating Shapes and Entering
Text
To create a shape, click one of the shape-drawing buttons and
drag.
To enter text, click the text-entry button, then click the
location where you want to insert text. While in this state, type
in the text with the keyboard.
To change the size of a shape or text, refer to "Dr. Engrave Changing the Size and Location of Shapes and Text."

Create a Raised Engraving (Relief)
Add thickness to shapes and text to create a relief.

1

Click the shape or text string you want for adding
thickness to select it.

2

.
Click the
The [Relief Size] dialog box appears.
The dialog box may differ depending on the type of object you selected. The following screen shows the dialog box that
appears when creating a relief of shapes or text.
Make the settings for the required items for creating the relief, then click [OK].

Enter the height of the bottom of the relief.
Enter the thickness of the relief.
These choose the configuration for pushing the
object up (or down).
These choose how to stack the relief.

These choose whether to push down or stack using
the value entered for the relief height.
This is for entering the angle of the base side when
has been selected.
This is for entering the direction of the relief ridge.
You can enter a value when a button other that
has been selected.
When this is selected, the relief of the
chosen object is smoothed.
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3

The display changes automatically to the screen at
right, and a three-dimensional view of the shape of
the relief appears.
This is called the "3D screen," and it displays the
shape of the relief and the tool path. You cannot
edit shapes or text.

Creating a Tool Path
A tool path is the path followed by the tool's blade tip. The tool path is generated from the cutting parameters that are presently set.
Before you create the tool path, make the settings for the cutting parameters. At the cutting parameters, make the settings for the
composition of the workpiece, the type of tool, and the cutting process.

1

From the [Cut] menu, click [Cutting Paremeters].
The [Cutting Paremeters] dialog box appears.
Make the settings for the necessary items for cutting, then click [OK].

This chooses the composition of the cutting material.
This sets the depth for cutting.
This chooses the cutting process.
Make the settings for the tool specifications.

2
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. When the tool path is created,
Click the
it appears in pink on the 3D screen.

Checking the Cutting Results
If Virtual MODELA is installed and set up, then before you perform actual cutting you can check the shape that will be produced after
cutting on the screen.

1

From the [File] menu, click [Output Preview].
Virtual MODELA starts.

2

The cutting data from 3D Engrave is imported into
Virtual MODELA.
An animated display of tool movement appears,
and the shape after cutting is gradually produced.

*

For more information on how to
operate Virtual
MODELA, see the
help for Virtual
MODELA.

Save the Data
Click the
.
The [Save As] dialog box appears.
Enter the name of the file and click [Save].

Start Engraving
Click the
.
When the screen at right appears, click [OK].
Cutting with MODELA starts.
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Description of Controls
This opens new file.

This types in the text

This opens an existing file.
This draws the shapes
This saves the file, overwriting the previous data.

This deletes the selected object and copies it to the
clipboard.

This copies the selected object to the clipboard.

This copies the clipboard data to the screen.

This switches to a flat (two-dimensional) shapeediting screen.
This switches to a solid (three-dimensional) display
screen.
Display this screen when you want to check a tool
path or the shape of a relief.
This adds thickness to shapes, text, images or other
flat objects to create a relief (raised engraving).
This creates a tool path for engraving for the selected
shapes and text.
The tool path for engraving appears on the 3D screen
as a red line.
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This selects a shape or text.

This is used to reposition the vertices of a polygon,
changing its shape.
These are used to retouch
imported images.
This zooms the screen in or out.
The mouse operations for the 2D screen and the 3D
screen are different.
This changes the display location of the object.
This moves the screen display to show areas outside
the window which are not visible.
This changes the perspective of the relief when you
drag the screen.
This is available only during 3D screen.
This command expands or reduces the size of the
object shown to fill the screen.
These select the pen width for
retouching an image.

This creates the path that the tip of the blade traces
(the tool path).
The tool path for cutting appears on the 3D screen as
a pink line.

These change the context of an object.

This outputs the tool path to the MODELA and starts
cutting.

These set the direction of the text string.

10 What to Do If...
<The MODELA doesn't operate>
Is the STANDBY key on (with the STANDBY LED lit up)?
Press the STANDBY key.
Has operation not been paused by pressing the VIEW key (lighting up the VIEW LED)?
Press the VIEW key to cancel the View state.
Are the cable connected correctly?
Check the output ports for MODELA and the computer and make sure they are connected correctly.
Is the cable for the connection with the computer suited to the MODELA and the computer?
- For the cable, use a separately available crossover serial cable (RS-232C rating). A straight serial cable such as is commonly used to
connect a modem cannot be used.
Are the settings for the computer and the software correct?
Check the following and make the correct settings.
Data output port
Communication parameters
Selected output device

: Port connected to any one of COM1 through COM4
: Bit rate of 9,600, no parity, one data bit, stop bit 8, and hardware handshaking
: MDX-15 or MDX-20

<Pressing the STANDBY key does not switch off the power.>
Unplug the AC adapter from the unit.

<The MODELING MODE LED or SCANNING LED Flashes Rapidly (Ten Times Per Second) >
Was the power switched on in the correct sequence?
First turn on the computer, then turn on MODELA.
This indicates a communications error.
Switch off the power, then check the cable connections and the port setting for the driver.
Was the computer restarted?
When the computer has been restarted, switch the power to the MODELA off, wait a few seconds, then switch it back on.

<All LEDs Flash Slowly (every 0.5 sec.) >
Has the cord come loose from the spindle unit or the sensor unit?
Switch off the power and reconnect the cords to the jacks.

<Errors During Cutting>
Speed drops during cutting
When cutting a material of uneven hardness, such as wood, the MODELA may slow down automatically (to a minimum speed of 0.1 mm
(0.00394 in.) /sec.). Once the MODELA has gone beyond the hard area, cutting continues at normal speed.

The STANDBY LED is flashing slowly (every 0.5 sec.)
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The material cannot be cut, even when the speed is reduced. Switch the power off and back on.
Make sure the blade being used is appropriate for the hardness of the material in use. Modify the software settings to cut the material a
little at a time.

Tool movement is different than the data
If an attempt is made to cut more deeply than the range of movement for the MODELA allows, the tool automatically rises to the
uppermost point.
Check to make sure that depth settings in the cutting data are not too deep, and that the tool extending from the spindle unit is not too
short.

Correct cutting is impossible
Are the blade, spindle, and workpiece all installed and loaded securely?
Retighten the setting screw for the blade and the mounting screws for the spindle.

Unusual noise is heard from the spindle
The spindle unit is a consumable part. Replace with a new spindle unit after 700 hours of use.

The spindle motor does not run
The spindle motor is a consumable part. Replace with a new spindle motor after 700 hours of use.

The VIEW LED is flashing slowly (every 1 sec.)
Is the front cover detached?
Install the front cover.
When a sensor unit is installed, the VIEW LED does not flash.

<The SCANNING LEDs repeatedly flashes twice>
Somthing touched the sensor during initial operation immediately after switching on the power, or a hardware error occurred.
If there is an obstruction, then switch off the power, remove the obstruction, and switch the power back on.
If there was a hardwarre error, then switch the power off and back on and repeat the same operation.
If the same error display occurs, consult your authorized Roland dealer or service center.

<Unexpected Program Operation>
I can't open a file.
Does the program you’re using support the format of the file you’re trying to open?
Check the program and the file format, and make sure the combination is supported.
There is not enough memory available for processing.
Close all other applications, or restart Computer.
If the file cannot be opened even after restarting the program, there may not be enough free space left on the hard disk.
If this is the case, free up space on the hard disk by deleting unneeded files or moving them to another disk.
If the messages about insufficient memory still appears after doing this, it is recommended that you increase the amount of memory in
your computer.

The included software doesn't function.
Does the computer you're using provide the correct operating environment for the included software?
Refer to the [Read Me] and check the operating environment, and use a computer that meets the operating-environment requirements.
Was the software installed using the setup program?
Be sure to use the setup program when installing the software.
The setup program puts the files for each software package in the necessary locations to enable the software to be used under Computer.

If an Error Message Appears
Refer to the help for the program you’re using.
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11 Items That May Not Be Copied
Unauthorized reproduction of a copyrighted item for any purpose other than personal use may be a violation of copyright. Roland DG
Corp. will not be responsible for any violation of third-party copyright by any article made through use of this product.
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12 Specifications
Main Unit Specifications
MDX-20
MDX-15
220 mm (X) x 160 mm (Y) ( 8-5/8 in. x 6-1/4 in. )
170 mm (X) x 110 mm (Y) ( 6-11/16 in. x 4-5/16 in. )
203.2 mm (X) x 152.4 mm (Y) x 60.5 mm (Z)
152.4 mm (X) x 101.6 mm (Y) x 60.5 mm (Z)
(8 in. (X) x 6 in. (Y) x 2-3/8 in. (Z))
(6 in. (X) x 4 in. (Y) x 2-3/8 in. (Z))
1000 g (2.2 lb.)
500 g (1.1 lb.)
Serial (RS-232C)
STANDBY key, VIEW key, TOOL-UP key, TOOL-DOWN key,
SCANNING MODE LED, MODELING MODE LED, VIEW LED
Exclusive AC adapter (DC+19V 2.1 A)
Standby mode
: under 35 dB (A)
Operation mode (not cutting) : under 70 dB (A) (According to ISO 7779)
476.8 mm (W) x 381.6 mm (D) x 305 mm (H)
426 mm (W) x 280 mm (D) x 305 mm (H)
(18-13/16 in. (W) x 15-1/16 in. (D) x 12-1/16 in. (H))
(16-13/16 in. (W) x 11-1/16 in. (D) x 12-1/16 in. (H))
13.7 kg (30.2 lb.)
9.6 kg (21.2 lb.)
5 to 40°C (41 to 104°F)
35 to 80 % (no condensation)
AC adapter: 1, power code: 1, Roland Software Package CD-ROM: 1, spindle unit: 1, sensor unit: 1, cap
screw M4x15: 4, tool:1, set screw M3x3: 2, double-sided tape: 1, front cover: 1, hexagonal wrench (size :
3 mm) :1, hexagonal wrench (size : 1.5 mm): 1 positioning pins: 3, clay: 1, MDX-20/15 user's manual: 1

XY table size
Max. operation area
Max. table load weight
Interface
Control keys
LED
Power consumption
Acoustic noise level
External dimensions
Weight (unit only)
Operation temperature
Operation humidity
Accessories

Modeling Functions
Tool chuck
Spindle motor
Software resolution
Mechanical resolution
Revolution speed
Feed rate
Acceptable material
Acceptable tool

: 6 mm or 1/8 in. tool chuck included
: 10W (DC motor)
: 0.025 mm/step (0.000984 in./step)
: 0.00625 mm/step (0.000246 in./step)
: 6500 rpm
: 0.1 to 15 mm/sec. (0.00393 to 9/16 in./sec.)
: Wood, Plaster, Resin (modeling wax, styrenform), Chemical wood, Aluminum (A5052 according to JIS),
Brass
: Endmil, Drill

Scanning Functions
Sensor
Scanning method
Scanning pitch
(Dr. PICZA)
Scanning speed
Exportable file formats

: Roland Active Piezo Sensor (R.A.P.S.)
Probe length 60 mm (2-5/16 in.), tip bulb diameter 0.08 mm (0.00315 in.)
: Contacting, mesh-point height-sensing
: X/Y-axis directions -- 0.05 to 5.00 mm (0.002 to 0.20 in.) (settable in steps of 0.05 mm (0.002 in.))
Z-axis direction -- 0.025 mm (0.000984 in.)
: 4 to 15 mm/sec. (1/8 to 9/16 in./sec.)
: DXF, VRML, STL, 3DMF, IGES, Grayscale, Point Group and BMP

Interface Specification
[Serial]
Standard
Transmission method
Transmission speed
Parity Check
Data Bits
Stop Bits
Handshake
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:
:
:
:
:
:
:

RS-232C specifications
Asynchronous, duplex data transmission
9600 bps
None
8 bits (fixed)
1 bits (fixed)
Hardwire

Serial connector (RS-232C)
Signal
number

Terminal
number

Signal
number

NC

25

13

NC

NC

24

12

NC

NC

23

11

NC

NC

22

10

NC

NC

21

9

NC

DTR

20

8

NC

NC

19

7

SG

NC

18

6

DSR

NC

17

5

CTS

NC

16

4

RTS

NC

15

3

RXD

NC

14

2

TXD

1

FG

Pin connection

13

1

25

14
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Please read this agreement carefully before opening the sealed
package or the sealed disk package
Opening the sealed package or sealed disk package implies your acceptance of the terms and conditions of this agreement.
If you do NOT accept this agreement, retain the package UNOPENED. (This product is just one of included items. Please
be aware that any amount of the purchase price will not be refunded for return of this product as a single item, regardless
of whether the package is opened or unopened.) The enclosed Roland product is a single user version.

Roland License Agreement
Roland DG Corporation ("Roland") grants you a non-assignable and non-exclusive right to use the COMPUTER
PROGRAMS in this package ("Software") under this agreement with the following terms and conditions.
1. Coming into Force

This agreement comes into force when you purchase and open the sealed package
or sealed disk package.
The effective date of this agreement is the date when you open the sealed package
or sealed disk package.

2. Property

Copyright and property of this Software, logo, name, manual and all literature
for this Software belong to Roland and its licenser.
The followings are prohibited :
(1) Unauthorized copying the Software or any of its support file, program module
or literature.
(2) Reverse engineering, disassembling, decompiling or any other attempt to
discover the source code of the Software.

3. Bounds of License

Roland does not grant you to sub-license, rent, assign or transfer the right granted
under this agreement nor the Software itself (including the accompanying items)
to any third party.
You may not provide use of the Software through time-sharing service and/or
network system to any third party who is not individually licensed to use this
Software.
You may use the Software by one person with using a single computer in which
the Software is installed.

4. Reproduction

You may make one copy of the Software only for back-up purpose. The property
of the copied Software belongs to Roland.
You may install the Software into the hard disk of a single computer.

5. Cancellation

Roland retains the right to terminate this agreement without notice immediately
when any of followings occurs :
(1) When you violate any article of this agreement.
(2) When you make any serious breach of faith regarding this agreement.

6. Limitations on Liability

Roland may change the specifications of this Software or its material without
notice.
Roland shall not be liable for any damage that may caused by the use of the
Software or by exercise of the right licensed by this agreement.

7. Governing Law

This agreement is governed by the laws of Japan, and the parties shall submit to
the exclusive jurisdiction of the Japanese Court.
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